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2. Bevezető 

Ennek a tájékoztatónak az a célja, hogy az elektronikus aláíráshoz és/vagy titkosításhoz 
használható szoftverek beállítása minél zökkenő mentesebben megtörténjen, illetve hogy a 
használat könnyen elsajátítható legyen. 

 

Amennyiben bármilyen kérdése van vagy problémája támad, Ügyfélszolgálatunk az (40) 22-55-22 
telefonszámon, a support@netlock.hu e-mail címen vagy személyesen a 1101 Budapest, Expo tér 
5-7. szám alatt, munkanapokon 9 és 17 óra között készséggel áll rendelkezésére. 

3. A Microsoft Office 2007-ről 

A Microsoft Office 2007 egy több alkalmazást tartalmazó irodai programcsomag, melyek közül 
egyes komponensek rendelkeznek digitális aláírást támogató részekkel. 

A csomag digitális aláírást támogatórészei: 

Excel  táblázatkezelő 

PowerPoint prezentáció (bemutató) készítő 

Word  szövegszerkesztő 

Továbbá Word és Excel esetében megjelent az Aláírási mező beszúrása funkció, mely egy 
hasznos új eszköz, és melynek használatát szintén tárgyalja ezen dokumentáció. 

4. Operációs rendszer követelmények 

A tanúsítványok használatához ajánlott minimum operációs rendszer követelmény: 

Windows XP SP3 

Vista SP1 

Windows 7 

5. Formátum korlátozások 

Az Office 2007 lehetővé teszi, hogy 97-2003 verzióval kompatibilis mentést hajtsunk végre az 
alkalmazásból. 

A digitálisan aláírt dokumentumokról egy ilyen fájlformátum váltás során az aláírás lekerül, azt az 
új formátumban mentett fájl esetén újra alá kell írni. 

Office 2007-ben kompatibilis formában mentve, és aláírva és Office 2003-ban a digitális aláírás 
jelzés nem látszik azonban a dokumentum aláírt.  

Office 2003-ban aláírva, Office 2007-ben megnyitva az aláírás látszik és érvényes a jelzése s. 

mailto:support@netlock.hu
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5.1. Rövid áttekintés a tanúsítvány igénylési - és tárolási megoldásokról 

A tanúsítványok létrehozása és tárolása többféleképpen történhet. Ezek különbségeiről olvashat a 
következőkben, amely hasznos lehet a beállításhoz. Természetesen a beállítás elvégezhető ezen 
rövid áttekintés elolvasása nélkül, de amennyiben új digitális aláírás használó, javasoljuk elolvasni. 

5.2. Tanúsítvány igénylése Mozilla böngészőn keresztül 

A Mozilla böngészők, levelezők a több operációs rendszeren használhatóság érdekében a 
tanúsítványokat egy-egy saját védett tárolóban tárolják, melyhez csak az adott, illetve az ezt 
megfelelően kezelni tudó alkalmazás fér hozzá, az operációs rendszer irányából nem látszik. 

Amikor Mozilla böngészővel hoz létre weboldalunkon egy kérelmet, akkor a privát kulcs a 
böngésző saját tárában jön létre, ott tárolódik, és a később kiadott tanúsítványt a Mozilla 
böngészővel az ügyfélmenü importálás pontját választva helyezi be véglegesen a tárolóba, ez után 
lesz az használható. 

Ekkor készíthet róla biztonsági mentést, mely a szabványos PKCS#12 (vagy másik nevén PFX) 
fájlformátumban jön létre. 

Fontos megjegyezni, hogy a böngésző is védi ezt a kulcsot (Mesterjelszó), amit első alkalommal 
Ön állít be, amennyiben ezt a jelszót elfelejti, nincs lehetőség a későbbiekben sem a tanúsítvány 
használatára, ezért a böngésző védelmi jelszavát biztonságosan tárolja. 

Mivel minden egyes Mozilla termék, külön tanúsítványtárral rendelkezik, ha másik Mozilla 
termékből kívánja használni tanúsítványát, arról itt mentést kell készítenie, és oda is telepítenie 
kell azt. 

Fontos! A tanúsítványkérelem beadása (kulcsgenerálás) és az elkészült tanúsítvány importálása 
közötti időszakban, ne telepítse újra operációs rendszerét, se böngészőjét, mivel ezzel 
helyreállíthatatlanul törli a tanúsítványához tartozó privát kulcsot is; e nélkül pedig az 
használhatatlan lesz. 

5.3. Tanúsítvány igénylése Internet Exploreren keresztül 

A Windows operációs rendszer biztosít egy központi tanúsítvány tárat, amelyet az alkalmazások, 
amelyeket erre felkészítettek, elérhetnek. Ehhez a tárhoz fér hozzá a teljesség igénye nélkül a 
Microsoft Internet Explorer, az Outlook és Outlook Express programok, illetve a digitális 
aláírásra képes Office alkalmazások is. 

Amikor Internet Explorer böngészővel hoz létre weboldalunkon egy kérelmet, akkor a privát 
kulcs a Windows operációs rendszer tanúsítványtárában jön létre, ott tárolódik, és a később 
kiadott tanúsítványt az Internet Explorer böngészővel, az ügyfélmenü importálás pontját 
választva helyezi be véglegesen a tárolóba, ez után lesz az használható. 
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Ekkor készíthet róla biztonsági mentést, mely a szabványos PKCS#12 (vagy másik nevén PFX) 
fájlformátumban jön létre. 

Fontos! A tanúsítványkérelem beadása (kulcsgenerálás) és az kiadott tanúsítvány importálása 
közötti időszakban ne telepítse újra operációs rendszerét, se böngészőjét, mivel ezzel 
helyreállíthatatlanul törli a tanúsítványához tartozó privát kulcsot is, e nélkül pedig az 
használhatatlan lesz. 
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5.4. Tanúsítvány és kulcsok kriptográfiai eszközön (kártyán, tokenen) 

Igen népszerű igénylési mód a tanúsítványok kártyán vagy tokenen való igénylése, mely az 
eszközök és a hozzá tartozó PIN kód miatt egy fokkal magasabb biztonságot is nyújt. 

Az ilyen eszközökben a privát kulcs biztonságosan tárolódik, az egyes aláírási műveletek közben 
sem kerül ki az eszközből, hanem az kapja meg a feladatot, és PIN kód kérés után adja vissza az 
eredményt. 

Amikor egy ilyen eszközt használ, akkor előtte természetesen a meghajtó (driver) programokat 
telepítenie kell a gépre, melyek telepítése során az eszköz a Windows tanúsítványtárával magas 
fokon integrálódik, tehát Windows tanúsítványtárat használó alkalmazások (a teljesség igénye 
nélkül: a Microsoft Internet Explorer, az Outlook és Outlook Express programok, illetve a 
digitális aláírásra képes Office alkalmazások) rögtön használni tudják. 

Amennyiben az alkalmazás NEM használja a Windows tanúsítvány tárat (például Mozilla 
programok) természetesen meg kell mondani az alkalmazásnak, hogy hogyan éri el az eszközt. 
Ezért bonyolultabb például a Mozilla programok beállítása. 

Az ilyen eszközön kiadott tanúsítványokról egyébként nem tud PKCS#12 (vagy másik nevén 
PFX) mentést csinálni, mert a kártyáról a privát kulcs nem szedhető ki. 

 

5.5. Tanúsítvány és kulcsok PKCS#12 (PFX) állományban 

Mint az előbbiekben olvashatta, a PKCS#12 (vagy másik nevén PFX) fájlformátum alapvetően 
biztonsági mentés, illetve kulcsok és tanúsítványok együttes mozgatása gépek között céljára 
szolgálhat. Ilyen formában tanúsítványt nem tud igényelni, hanem csak létrehozni tudja azokat, 
melyeket helyreállítási céllal egyébként is lényeges megtennie. 

 

6. A tanúsítványok telepítése 

Az előző fejezetekben áttekintetteknek megfelelően, a következők leírják, hogyan tudja a 
tanúsítványát beállítani a használathoz. 

6.1. Ha a tanúsítvány kártyán, tokenen található 

Amennyiben tanúsítványát kriptográfiai eszközön kapta meg, akkor a kriptográfiai eszköz 
telepítési útmutatója leírja, hogyan importálható a tanúsítvány a Windows tanúsítványtárba. 
Kérjük, hajtsa végre az ott leírtakat. 

 



 

 

 

 

 

 

 

 

7(16) 
 

 

6.2. Ha a tanúsítvány már a gépen található 

Ha a tanúsítvány a tanúsítvány igénylését (fokozott biztonságú tanúsítvány esetén) Internet 

Explorerből intézte, a tanúsítvány kiadási folyamat végén a tanúsítvány és a kulcsok 

megtalálhatók az Ön gépén. 

Ekkor nincs szükség a tanúsítvány telepítésére, azonban biztonsági másolatot érdemes 

létrehoznia. 

6.3. Ha a tanúsítványkérelem beadása Mozilla böngészőn keresztül történt 

Amennyiben a kérelmet Mozilla böngészőn keresztül adta be, a később kiadott tanúsítványt a 
Mozilla böngészővel, a NetLock ügyfélmenüjébe belépve (itt: Tanúsítványok menüpont> Kiadott 
tanúsítványok) az importálás pontot választva tudja véglegesen Mozilla saját tanúsítványtárolójába 
behelyezni, majd ezt importálnia kell, és a Windows tanúsítvány tárba telepítenie. 

6.3.1. Tanúsítvány exportálása Firefox böngészőből Windows tanúsítványtárba 
telepítéshez 

A Firefox böngésző az egyik leggyakoribb Mozilla böngésző, ezért a PKCS#12 mentés készítését 
ezen mutatjuk be, a többi Mozilla termék PKCS#12 mentés készítését az adott termékhez készült 
dokumentáció mutatja be. 

 

1. Indítsa el a Firefox böngészőt. 

2. Navigáljon el a Tanúsítványok menüpontig. Eszközök > Beállítások > Haladó > 
Titkosítás fül > Tanúsítványkezelő gomb (Tools > Options > Advanced > Encryption 
fül > Manage certificates gomb). 

3. A megjelenő ablakban a Saját tanúsítványok (Your certificates) fülön válassza ki 
mentendő tanúsítványt, majd nyomja meg a Mentés (Backup) gombot. 

4. A következő ablakban adja meg a mentés helyét. 

5. Ezt követően adja meg Firefox-on belüli tanúsítványvédelmi jelszót. (mesterjelszó / 
master password) (Ez az első tanúsítvány export-import előtt nincs beállítva, ekkor 
kétszer kell begépelnie, és a későbbiek során ez után fog rendszeresen érdeklődni a 
Firefox böngésző.) 

6. Ezután adja meg a .pfx fájl jelszavát, amellyel védeni kívánja, ezt a jelszót jegyezze is fel. 

7. A mentés után tájékoztatást kap, hogy az sikeresen megtörtént, majd nyomjon Ok 
gombot az összes ablak bezáródásáig. 

 

A tanúsítvány exportálása ezzel megtörtént. Javasolt az exportált állományt a telepítés után, mint 
biztonsági másolatot biztonságos helyre eltenni. 

A következő fejezet ismerteti a PKCS#12 állományok telepítését. 
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6.4. PKCS12 (PFX) fájlban található tanúsítvány telepítése Windows tanúsítványtárba 

Abban az esetben, ha tanúsítványát nem kriptográfiai eszközön szerezte be, és nem Internet 
Explorer böngészőn keresztül igényelte, akkor az arról készült PKCS#12 (.pfx) formátumú 
mentett állomány segítségével is tudja tanúsítványát a Windows tanúsítványtárban beállítani. 

A Windows tanúsítványtárba a tanúsítvány és kulcs importálásának folyamata a következő: 

1. Ahhoz, hogy a gépén található PKCS#12 állományt telepítse, kattintson kétszer az 
Intézőből (Explorer) a *.pfx, (*.p12) kiterjesztésű fájlra. Ekkor a tanúsítvány telepítése 
varázsló indul el. 

2. Az üdvözlő képernyőn nyomja meg a Tovább (Next) gombot. 
3. A második képernyőn az importálandó fájl nevét látja. Itt nincs semmi teendő, lépjen 

tovább a Tovább (Next) gomb segítségével. 
 

4. A következő képernyőn adja meg a 
PKCS#12 fájlhoz tartózó jelszót. Itt 
állíthatja be a tanúsítvány erős védelmét 
és későbbi exportálhatóságát. Javasoljuk 
mindkét opciót kipipálni és ezután a 
Tovább (Next) gombot megnyomni. 

 
 
 

5. A következő képernyő megkérdezi, hogy 
automatikus vagy kézzel történő 
elhelyezést kíván a megfelelő 
tanúsítványtárolóban. Itt válassza az 
Automatikus kiválasztást (Automatically...), majd kattintson a Tovább (Next) gombra. 

6. Az utolsó képernyőn kattintson a Befejezés (Finish) gombra. 

A tanúsítvány telepítése ezzel megtörtént. 
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7. Dokumentumok aláírása 

 

1. A dokumentum aláírását az Office gomb > Előkészítés > Digitális aláírás hozzáadása 
(Office gomb > Prepare > Add Digital Signature) kiválasztásával tudjuk kezdeményezni. 
Aláírni csak már mentett dokumentumot lehet, amennyiben ez még nem történt meg, 
az alkalmazás figyelmeztet arra, hogy az aláírás előtt azt menteni kell. 

2. A következő ablak jelenik meg: 

                                
Itt meg kell adnunk az aláírás okát szövegesen, majd a Módosítás gombbal (Change) 
kiválaszthatjuk a tanúsítványt. Ha a megfelelő van kiválasztva, az Aláírás (Sign) gombbal 
elvégezhető az aláírás. 

3. Amennyiben a számítógépünkre kriptográfiai eszközön tárolt (smart kártya, USB token) 
tanúsítvány korábban került telepítésre, az operációs rendszer kéri az eszköz behelyezést, 
csatlakoztatását, majd a PIN kód megadását. 

4. Az érvényes aláírásról a státusz sorban megjelenő piros pecsét ikon tanúskodik. Ez után 
mentve az állományt, az aláírtként mentődik.  

 

 
 

Aláírás után a dokumentum nem módosíthatóvá válik, a pecsét ikora kattintva, az 
Aláírások szalagon megtekinthetjük a dokumentumon található aláírásokat, illetve azok 
indokát. A módosításhoz az aláírást törölnünk kell (Aláírás eltávolítása). 

5. Ha egy dokumentumot több tanúsítvánnyal kívánunk aláírni, ez megtehető a fenti 
módon, az összes tanúsítványt egyenként kiválasztva. 

 

Ez az 
Office 
gomb 
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8. Dokumentumok aláírásának megtekintése, ellenőrzése 

Aláírt dokumentumon a megnyitása után a következő helyen látszik, hogy aláírt: 

 

1. A státuszsorban található pecsétre kattintva ellenőrizhető az aláírás: 

 

 
 

Aláírás után a dokumentum nem módosíthatóvá válik, a pecsét ikora kattintva az 
Aláírások szalagon megtekinthetjük a dokumentumon található aláírásokat, illetve azok 
indokát (ehhez a legördülő menüből az Aláírás részleteire kell kattintani). A módosításhoz 
az aláírást törölnünk kell (Aláírás eltávolítása). 
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9. Aláírási sor használata 

Az Aláírási mező (Signature line) koncepciója az, hogy a felhasználó egy dokumentumba ilyet 
elhelyezve, az mind nyomtatásban megfelelően nézzen ki, mind elektronikusan biztosítson 
lehetőséget az aláírás elhelyezésére. 

9.1. Aláírási sor beszúrása dokumentumba 

A beszúráshoz a Beszúrás > Aláírási sor (Insert > Signature line) menüpontot kell kiválasztani. 

A megjelenő ablakban kell megadnunk az 
aláírás különböző tulajdonságait. 

 javasolt aláíró, (suggested signer) akitől 
elvárjuk, hogy a mezőben aláírjon 

 javasolt aláíró beosztása (title) 

 a javasolt aláíró email címe (e-mail address) 

 utasítások az aláírónak (instructions) 

Megjelölhető még két opció: 

 az aláíró megjegyzéseket vehet fel az 
Aláírás párbeszédpanelen (Allow singer to 
add comment...) 

 az aláírás dátumának megjelenítése az 
aláírási sorban (show sign date...) 

 

Az Ok gomb megnyomása után valami ilyesmit kell látnunk: 

 

Mint látható, az Aláírások panelon is megjelent az elvárt aláírás. 
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9.2. Aláírás helyezése az aláírási sorba 

 

Az aláírás elhelyezése egy ilyen mezőbe gyerekjáték, csupán duplán kattintanunk kell a mezőre, és 
ekkor megjelenik egy ehhez hasonló ablak. 

A felső dobozban megjelenik az a 
szöveg, amit a mező 
létrehozásakor, mint útmutatót az 
aláíráshoz megadtunk. 

Az alatta található részen KELL 
vagy szövegesen megadnunk a 
nevünket, vagy kiválasztanunk egy 
képet az aláírásunkhoz. 

Az alsó aláírási cél (purpose) mező 
csak akkor jelenik meg, ha a mező 
beszúrásakor a megjegyzés 
hozzáfűzési lehetőség opciót 
bekapcsoltuk. 

Az legalsó aláírás mezőben a 
Módosítás (Change) gombbal 
kiválaszthatjuk a tanúsítványunkat, 
illetve megváltoztathatjuk az ott 
éppen láthatót, ha az nem 
megfelelő. 

A lépések a következők: 

1. A Kép kiválasztása (Select image) opcióra kattintva tallózzuk ki a használni kivánt képet 
vagy megadjuk az előtte lévő dobozba szövegesen a nevünket. 

(Ez lehet akár a beszkennel aláírásunk is, de biztonsági okokból, figyeljünk arra, hogy a 
felbontása lehetőség szerint ne legyen túlságosan jó minőségű, hiszen szkennelt aláírásunk 
birtokában nem elektornikus dokumentumokat azért még meg lehet hamisítani.) 

2. Ha lehet, és van hozzáfűzni valónk, töltsük ki a megjegyzés mezőt. 

3. Ha nem a megfelelő tanúsítványt látjuk alul, válaszzuk ki a Módosítás (Change) gomb 
segítségével. 

4. Nyomjunk rá az Aláírás (Sign) gombra. 

5. Ez után tanúsítványunknak megfelelően a rendszer kérheti kártyán behelyezését és PIN 
kód megadását, vagy csak egyszerűen elvégzi az aláírást. Az aláírás után a dokumentumot 
automatikusan lementi, nem kell nekünk újra lementeni azt. 
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9.3. Példa egy aláírt aláírási sorra 

 

Példánkban Varga Viktor minősített elektronikus aláírásával láttunk el egy rövid dokumentumok, 
és képként az aláíráshoz korunk legnagyobb énekesnőjének Britney Spearsnek aláírását 

válaszottuk. (  ) 

 

 
 

Az aláírt aláírási sorral rendelkező dokumentumon, a megnyitása után több helyen látszik, hogy 
aláírt: 

 

A státuszsorban (a képernyő alján) található pecsét: 

 
Aláírás után a dokumentum nem módosíthatóvá válik, a pecsét ikora kattintva az Aláírások 
szalagon megtekinthetjük a dokumentumon található aláírásokat, illetve azok indokát. A 
módosításhoz az aláírást törölnünk kell. 
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10. Függelék A – Office 2007 PDF modul beállítása szabványos PDF állományok 
létrehozásához 

 

Az alábbiakban az Office 2007 bővítményeként szolgáló PDF modul beállításait taglaljuk, 
melynek segítségével szabványos formában jönnek létre az egyes PDF fájlok. Ennek előnye 
(többek között) hogy a például a PDFSigno alkalmazással is alá lehet írni ezeket. 

 

A beépülő-modul telepítő csomagja letölthető az alábbi címek egyikéről: 

Magyar nyelvű Office 2007-hez: 
http://www.microsoft.com/downloads/details.aspx?displaylang=hu&FamilyID=4d951911-
3e7e-4ae6-b059-a2e79ed87041 

Angol nyelvű Office 2007-hez: 
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=4d951911-
3e7e-4ae6-b059-a2e79ed87041 

A telepítést pozitív helyeslő válaszadással tovább kell engedni, azt követően az alábbi beállításokat 
szükséges eszközölni: 

Az Office logóra kattintva > Mentés Másként > PDF vagy XPS > fájlnév megadása > Beállítások 
> ISO 19005-1-kompatibilitás (PDA/A) > OK > Közzététel (Mentés) 

http://www.microsoft.com/downloads/details.aspx?displaylang=hu&FamilyID=4d951911-3e7e-4ae6-b059-a2e79ed87041
http://www.microsoft.com/downloads/details.aspx?displaylang=hu&FamilyID=4d951911-3e7e-4ae6-b059-a2e79ed87041
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=4d951911-3e7e-4ae6-b059-a2e79ed87041
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=4d951911-3e7e-4ae6-b059-a2e79ed87041
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1. ábra - Office 2007 "PDF vagy XPS" modul beállítása 
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11. Függelék B –  Biztonsági másolat készítése tanúsítványairól és kulcsairól 

 

Ha tanúsítványa fokozott biztonságú és NEM kriptográfiai eszközön kapta meg, akkor érdemes a 
tanúsítványáról PKCS#12 (*.pfx) állományban biztonsági másolatot készíteni, hiszen a 
számítógép sérülése, illetve újratelepítése után csak ebből tudja a tanúsítványt visszaállítani. 

 

1. A kulcs és tanúsítvány exportálásához indítson Internet Explorer böngészőt. 

2. Navigáljon el a tanúsítványok menüponthoz. (Eszközök > Internet beállítások > 
Tartalom fül > Tanúsítványok gomb) (Tools > Internet Settings > Content fül > 
Certificates gomb) 

3. Válassza ki a Saját (Personal) lapon a tanúsítványok közül az exportálandót, majd nyomja 
meg az Export gombot. 

4. A megjelenő tanúsítvány exportáló varázsló üdvözlő képernyőjén nyomja meg a Tovább 
(Next) gombot. 

5. A következő ablakban válassza a privát kulcs 
exportálását is (Yes, export the private...), majd 
kattintson a Tovább (Next) gombra. 

6. A következő ablakban a második rádiógombhoz 
tartozó szekció érhető csak el. Itt állítson be 
Erős titkosítást (Enable strong protection). Ha 
szüksége van arra, hogy a tanúsítvánnyal együtt a 
hozzá tartozó gyökértanúsítványt is exportálja, 
akkor jelölje ki a Minden tanúsítvány exportálása 
opciót (Include all certificates...) is. Ha a privát 
kulcsot törölni akarja az exportálás után erről a 
gépről, akkor jelölje be a privát kulcs törlése 
(Delete the Private...) opciót is. 

7. A következő ablakban adja meg kétszer azt a 
jelszót, amelyet szeretne a fájlnak adni. Ez 
jegyezze meg jól, mert ennek ismeretében tudja 
telepíteni másik gépen tanúsítványát. 

8. A következő ablakban kiválaszthatjuk a fájlnevet, 
és a helyet, ahol a fájlt létre szeretnénk hozni. 

9. Miután ezt beállította, már csak a Tovább (Next) és végül a Befejezés (Finish) gombot kell 
megnyomnia, valamint a megnyitott ablakokat OK gombbal bezárnia. 

A tanúsítvány exportálása ezzel megtörtént. 

Ezt az állományt érdemes biztonságos helyen elzárni valamilyen adathordozón. 


